
CAN

Getting Started with Your CAN
Hardware and the NI-CAN™ 

Software for Windows 95

Getting Started with CAN for Windows 95
January 1998 Edition
Part Number 321371C-01



725 11, 
91, 
4 00, 
7 1200, 
Internet Support
E-mail: support@natinst.com
FTP Site: ftp.natinst.com
Web Address: http://www.natinst.com

Bulletin Board Support
BBS United States: 512 794 5422
BBS United Kingdom: 01635 551422
BBS France: 01 48 65 15 59

Fax-on-Demand Support
512 418 1111

Telephone Support (USA)
Tel: 512 795 8248
Fax: 512 794 5678

International Offices
Australia 03 9879 5166, Austria 0662 45 79 90 0, Belgium 02 757 00 20, Brazil 011 288 3336, 
Canada (Ontario) 905 785 0085, Canada (Québec) 514 694 8521, Denmark 45 76 26 00, Finland 09 725
France 01 48 14 24 24, Germany 089 741 31 30, Hong Kong 2645 3186, Israel 03 6120092, Italy 02 4130
Japan 03 5472 2970, Korea 02 596 7456, Mexico 5 520 2635, Netherlands 0348 433466, Norway 32 84 8
Singapore 2265886, Spain 91 640 0085, Sweden 08 730 49 70, Switzerland 056 200 51 51, Taiwan 02 37
United Kingdom 01635 523545

National Instruments Corporate Headquarters
6504 Bridge Point Parkway Austin, Texas 78730-5039 USA Tel: 512 794 0100

© Copyright 1996, 1998 National Instruments Corporation. All rights reserved.



 Important Information
e date 
eplace 

 
enced 
do not 
riod. 

ide 
 costs 

viewed 
right to 
 should 
ages 

 
nal 
rranty 

follow 
 
s, 

nical, 
hout 

ility 
edical 
 of the 
inical 
uards, 
 always 
ntended 
n health 
Warranty
The CAN hardware is warranted against defects in materials and workmanship for a period of one year from th
of shipment, as evidenced by receipts or other documentation. National Instruments will, at its option, repair or r
equipment that proves to be defective during the warranty period. This warranty includes parts and labor. 

The media on which you receive National Instruments software are warranted not to fail to execute programming
instructions, due to defects in materials and workmanship, for a period of 90 days from date of shipment, as evid
by receipts or other documentation. National Instruments will, at its option, repair or replace software media that 
execute programming instructions if National Instruments receives notice of such defects during the warranty pe
National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outs
of the package before any equipment will be accepted for warranty work. National Instruments will pay the shipping
of returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this manual is accurate. The document has been carefully re
for technical accuracy. In the event that technical or typographical errors exist, National Instruments reserves the 
make changes to subsequent editions of this document without prior notice to holders of this edition. The reader
consult National Instruments if errors are suspected. In no event shall National Instruments be liable for any dam
arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL  INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS 
ANY WARRANTY OF MERCHANTABILITY  OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’ S RIGHT TO RECOVER DAMAGES CAUSED 
BY FAULT OR NEGLIGENCE ON THE PART OF NATIONAL  INSTRUMENTS SHALL BE LIMITED  TO THE AMOUNT THERETOFORE PAID BY THE 
CUSTOMER. NATIONAL  INSTRUMENTS WILL  NOT BE LIABLE  FOR DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, 
OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of the liability of 
National Instruments will apply regardless of the form of action, whether in contract or tort, including negligence.
Any action against National Instruments must be brought within one year after the cause of action accrues. Natio
Instruments shall not be liable for any delay in performance due to causes beyond its reasonable control. The wa
provided herein does not cover damages, defects, malfunctions, or service failures caused by owner’s failure to 
the National Instruments installation, operation, or maintenance instructions; owner’s modification of the product;
owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third partie
or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mecha
including photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, wit
the prior written consent of National Instruments Corporation.

Trademarks
CVI™, LabVIEW™, natinst.com™, and NI-CAN™ are trademarks of National Instruments Corporation.

Product and company names listed are trademarks or trade names of their respective companies.

WARNING REGARDING MEDICAL AND CLINICAL USE OF NATIONAL INSTRUMENTS PRODUCTS
National Instruments products are not designed with components and testing intended to ensure a level of reliab
suitable for use in treatment and diagnosis of humans. Applications of National Instruments products involving m
or clinical treatment can create a potential for accidental injury caused by product failure, or by errors on the part
user or application designer. Any use or application of National Instruments products for or involving medical or cl
treatment must be performed by properly trained and qualified medical personnel, and all traditional medical safeg
equipment, and procedures that are appropriate in the particular situation to prevent serious injury or death should
continue to be used when National Instruments products are being used. National Instruments products are NOT i
to be a substitute for any form of established process, procedure, or equipment used to monitor or safeguard huma
and safety in medical or clinical treatment.



 
  FCC/DOC Radio Frequency Interference 

Class A Compliance

This equipment generates and uses radio frequency energy and, if not installed and used in strict accordance 
with the instructions in this manual, may cause interference to radio and television reception. Classification 
requirements are the same for the Federal Communications Commission (FCC) and the Canadian 
Department of Communications (DOC). This equipment has been tested and found to comply with the 
following two regulatory agencies:

Federal Communications Commission
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant 
to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful 
interference when the equipment is operated in a commercial environment. This equipment generates, 
uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction 
manual, may cause harmful interference to radio communications. Operation of this equipment in a 
residential area is likely to cause harmful interference in which case the user will be required to correct the 
interference at his own expense.

Notices to User: Changes or modifications not expressly approved by National Instruments could void 
the user’s authority to operate the equipment under the FCC Rules.

This device complies with the FCC rules only if used with shielded interface cables 
of suitable quality and construction. National Instruments used such cables to test 
this device and provides them for sale to the user. The use of inferior or nonshielded 
interface cables could void the user’s authority to operate the equipment under the 
FCC rules.

If necessary, consult National Instruments or an experienced radio/television technician for additional 
suggestions. The following booklet prepared by the FCC may also be helpful: Interference to Home 
Electronic Entertainment Equipment Handbook. This booklet is available from the U.S. Government 
Printing Office, Washington, DC 20402.

Canadian Department of Communications
This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment 
Regulations.
Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel brouilleur 
du Canada.
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This manual contains instructions to help you install and configure the
National Instruments CAN hardware and the NI-CAN software for 
Windows 95. The National Instruments CAN hardware includes the 
AT-CAN, AT-CAN/2, PCI-CAN, PCI-CAN/2, PCMCIA-CAN, and 
PCMCIA-CAN/2. 

This manual assumes that you are already familiar with Windows 95.

How to Use the Manual Set

Use this getting started manual to install and configure your CAN hardw
and the NI-CAN software for Windows 95.

Use the NI-CAN User Manual for Windows 95 and Windows NT to learn 
the basics of CAN and how to develop an application program. The us
manual also contains debugging information and detailed examples.

NI-CAN
User Manual

for Windows 95
and Windows NT

Application
Development
and Examples

Novice
Users

Experienced
Users

NI-CAN Programmer
Reference Manual

for Win32

Function
and Object

Descriptions

Getting Started
Manual

Installation and
Configuration
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Use the NI-CAN Programmer Reference Manual for Win32 for specific 
information about each NI-CAN function and object, such as format, 
parameters, and possible errors.

Organization of This Manual
This manual is organized as follows:

• Chapter 1, Introduction, explains how to use this manual, lists what 
you need to get started and optional equipment you can order, an
briefly describes the CAN hardware and the NI-CAN software for 
Windows 95.

• Chapter 2, Installation and Configuration, describes how to install and
configure the CAN hardware and the NI-CAN software for 
Windows 95.

• Chapter 3, Verify the Installation, describes how to verify the hardware
and software installation.

• Chapter 4, Begin to Use the NI-CAN Software, helps you get started 
with the NI-CAN software for Windows 95.

• Appendix A, Uninstalling the Hardware and Software, describes how 
to uninstall the CAN hardware and the NI-CAN software from 
Windows 95.

• Appendix B, Forcing Windows 95 to Detect the CAN Hardware, 
contains instructions to help you install your CAN interface if 
Windows 95 has not detected it properly.

• Appendix C, Cabling Requirements, describes the cabling 
requirements for the CAN hardware.

• Appendix D, Troubleshooting and Common Questions, describes how 
to troubleshoot problems and answers some common questions.

• Appendix E, Specifications, describes the physical characteristics o
the CAN hardware, along with the recommended operating conditio

• Appendix F, Customer Communication, contains forms you can use to
request help from National Instruments or to comment on our produ
and manuals.

• The Glossary contains an alphabetical list and a description of term
used in this manual, including abbreviations, acronyms, metric 
prefixes, mnemonics, and symbols.
Getting Started with CAN for Windows 95 x © National Instruments Corporation
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Conventions Used in This Manual
The following conventions are used in this manual.

» The » symbol leads you through nested menu items and dialog box opt
to a final action. The sequence File»Page Setup»Options»Substitute 
Fonts directs you to pull down the File menu, select the Page Setup item, 
select Options, and finally select the Substitute Fonts option from the last 
dialog box.

This icon to the left of bold italicized text denotes a caution, which advis
you of precautions to take to avoid injury, data loss, or a system crash

bold Bold text denotes the names of menus, menu items, parameters, dialo
boxes, dialog box buttons or options, icons, windows, Windows 95 tab
or LEDs.

bold italic Bold italic text denotes a caution.

CAN hardware CAN hardware refers to the AT-CAN, AT-CAN/2, PCI-CAN, PCI-CAN/2, 
PCMCIA-CAN, and PCMCIA-CAN/2 in cases where the material appli
to all the interfaces.

italic Italic text denotes emphasis, a cross reference, or an introduction to a
concept.

monospace Text in this font denotes text or characters that you should literally ent
from the keyboard, sections of code, programming examples, and syn
examples. This font is also used for the proper names of disk drives, pa
directories, programs, subprograms, subroutines, device names, funct
operations, variables, filenames, and extensions, and for statements a
comments taken from program code.

paths Paths in this manual are denoted using backslashes (\) to separate d
names, directories, folders, and files.

Related Documentation
The following documents contain information that you may find helpful 
you read this manual.

• ANSI/ISO Standard 11898-1993, Road Vehicles—Interchange of 
Digital Information—Controller Area Network (CAN) for High-Spee
Communication

!
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• CAN Specification Version 2.0, 1991, Robert Bosch Gmbh., 
Postfach 500, D-7000 Stuttgart 1

• CiA Draft Standard 102, Version 2.0, CAN Physical Layer for 
Industrial Applications

• DeviceNet Specification, Volume 1, Version 2.0, Open DeviceNet 
Vendor Association

• Microsoft Windows 95 User's Guide, Microsoft Corporation

Customer Communication
National Instruments wants to receive your comments on our products
and manuals. We are interested in the applications you develop with o
products, and we want to help if you have problems with them. To mak
easy for you to contact us, this manual contains comment and configura
forms for you to complete. These forms are in Appendix F, Customer 
Communication, at the end of this manual. 
Getting Started with CAN for Windows 95 xii © National Instruments Corporation
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Introduction

This chapter explains how to use this manual, lists what you need to g
started and optional equipment you can order, and briefly describes th
CAN hardware and the NI-CAN software for Windows 95.

How to Use This Manual

Yes

No

Chapter 3

Chapter 4

User Manual and
Programmer Reference

Manual
Write Application Program

Passes?

Gather What You Need
to Get Started

Chapter 1

Install the Hardware

Install the Software

Verify the Installation

Review Programming
Considerations

Troubleshooting
Appendix

Configure the Software

Chapter 2
 for Windows 95
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What You Need to Get Started
Make sure you have all of the items listed before you attempt to install
hardware and software.

❑ Windows 95 installed on your computer

❑ One of the following CAN interfaces, which is included in your kit:

AT-CAN
AT-CAN/2
PCI-CAN
PCI-CAN/2
PCMCIA-CAN
PCMCIA-CAN/2

❑ The following 3.5 in., high-density (1.44 MB) disks, which are 
included in your kit:

NI-CAN Software for Windows 95 and Windows NT (Disk 1)

NI-CAN Software for Windows 95 and Windows NT (Disk 2)

❑ PCMCIA-CAN cable, which is included in your kit, if you have a 
PCMCIA-CAN or PCMCIA-CAN/2

❑ CAN interface cables that meet the requirements in Appendix C, 
Cabling Requirements

CAN Hardware Overview
The National Instruments CAN hardware includes the AT-CAN, 
AT-CAN/2, PCI-CAN, PCI-CAN/2, PCMCIA-CAN, and 
PCMCIA-CAN/2.

The AT-CAN and AT-CAN/2 are fully software configurable and complian
with the Plug and Play ISA standard. With an AT-CAN or AT-CAN/2 
board, you can make your PC AT-compatible computer communicate w
and control CAN devices.

The PCI-CAN and PCI-CAN/2 are completely software configurable a
compliant with the PCI Local Bus Specification. With a PCI-CAN or 
PCI-CAN/2 board, you can make your PC-compatible computer with 
PCI Local Bus slots communicate with and control CAN devices.
Getting Started with CAN for Windows 95 1-2 © National Instruments Corporation
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The PCMCIA-CAN and PCMCIA-CAN/2 are Type II PC Cards that are
completely software configurable and compliant with the PCMCIA 
standards for 16-bit PC Cards. With a PCMCIA-CAN card or 
PCMCIA-CAN/2 card, you can make your PC-compatible notebook wi
PCMCIA sockets communicate with and control CAN devices.

The AT-CAN, PCI-CAN, and PCMCIA-CAN interfaces each have one 
CAN port. The AT-CAN/2, PCI-CAN/2, and PCMCIA-CAN/2 interfaces
each have two CAN ports.

CAN interfacing is accomplished using the Intel 82527 CAN controller
chip. The CAN physical layer fully conforms to the ISO 11898 physica
layer specification for CAN and is optically isolated to 500 V. AT-CAN an
PCI-CAN boards are available with two physical connector types: DB-
D-Sub and Combicon-style pluggable screw terminals. PCMCIA-CAN
cables include both a DB-9 D-Sub and a Combicon-style pluggable sc
terminal.  The CAN physical layer on AT-CAN and PCI-CAN cards can 
powered either internally (from the card) or externally (from the bus ca
power).  The power source for the CAN physical layer for each port is 
configured with a jumper.  There are two cables available for the 
PCMCIA-CAN cards.  In one cable the CAN physical layer is powered
internally (from the card).  In the other cable the CAN physical layer is
powered externally (from the bus cable power). The CAN hardware 
supports a wide variety of transfer rates up to 1 Mb/s.

All of the CAN hardware uses the Intel 386EX embedded processor to
implement time-critical features provided by the NI-CAN software. The
CAN hardware communicates with the NI-CAN driver through on-boar
shared memory and an interrupt.

NI-CAN Software Overview
The NI-CAN software includes a native, 32-bit multitasking Windows 9
driver that is fully Plug and Play aware. The driver components are 
dynamically loaded when Windows 95 detects new CAN hardware, an
dynamically unloaded when Windows 95 detects the removal of CAN 
hardware.

The NI-CAN software is fully integrated into the Windows 95 operating
system. You can configure it through the Windows 95 Device Manager, 
uninstall it through the Add/Remove Programs applet of the Control Pa
© National Instruments Corporation 1-3 Getting Started with CAN for Windows 95
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With the NI-CAN software, you can use multiple types of CAN hardwa
concurrently. For example, you can communicate with CAN devices 
through both a PCI-CAN and AT-CAN in the same system at the same ti

The NI-CAN software, along with the CAN hardware, transforms your 
computer into a CAN interface with complete communications and bus
management capability. The NI-CAN software includes the following 
components:

• Firmware (runs on embedded Intel 386EX)

• Device driver

• Diagnostic test utility

• Configuration utility

• Language interface libraries for Microsoft Visual C/C++ 2.0 or late
LabWindows/CVI 4.0 or later, and LabVIEW 4.0 or later

• Example programs that use NI-CAN functions

Optional Programming Tools
Your kit includes the NI-CAN software for Windows 95. In addition, yo
can order the LabWindows/CVI or LabVIEW software from National 
Instruments.

LabWindows/CVI is an interactive ANSI C development environment f
building test and measurement and instrument control systems. It inclu
interactive code-generation tools and a graphical editor for building cus
user interfaces. It also includes built-in libraries for IEEE 488.2, VXI, 
RS-232 control, and plug-in data acquisition. When you order 
LabWindows/CVI, you also get hundreds of complete instrument drive
which are modular, source-code programs that handle the communica
with your instrument so that you do not have to learn the programming
details.

LabVIEW is a complete programming environment that departs from t
sequential nature of traditional programming languages and features a
graphical programming environment. It includes all the tools needed fo
instrument control, data acquisition, analysis, and presentation. LabVI
also includes an extensive instrument driver library.

For more information about LabWindows/CVI and LabVIEW, contact 
National Instruments.
Getting Started with CAN for Windows 95 1-4 © National Instruments Corporation



© National Instruments Corporation 2-1 Getting Started with CAN
2

and 

tall 

to 
Installation and Configuration

This chapter describes how to install and configure the CAN hardware 
the NI-CAN software for Windows 95.

Install the NI-CAN Software
Before installing the CAN hardware, complete the following steps to ins
the NI-CAN software for Windows 95.

1. Select Start»Settings»Control Panel.

2. Double-click on the Add/Remove Programs icon in the Control Panel 
to launch the Add/Remove Programs applet. A dialog box similar 
the one in Figure 2-1 appears.

Figure 2-1.  Add/Remove Programs Properties Dialog Box
 for Windows 95
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You can use this same applet to uninstall the NI-CAN software at 
later time. Refer to Appendix A, Uninstalling the Hardware 
and Software, for more information.

3. Click on the Install  button.

4. Insert the NI-CAN Software for Windows 95 and Windows NT 
(Disk 1), and click on the Next button to proceed. The software 
installation wizard begins with the screen shown in Figure 2-2.

Figure 2-2.  NI-CAN Software Setup Screen

The setup wizard guides you through the necessary steps to insta
NI-CAN software. You may go back and change values where 
appropriate by choosing Back. You can exit the setup where 
appropriate by choosing Cancel.

5. Shut down your computer when the setup is complete.
Getting Started with CAN for Windows 95 2-2 © National Instruments Corporation
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Install the CAN Hardware
This section describes how to install your CAN hardware.

Install Your AT-CAN, AT-CAN/2, PCI-CAN, or PCI-CAN/2

Caution Before you remove the board from the package, touch the antistatic plastic 
package to a metal part of your system chassis to discharge electrostatic ener
which can damage several components on your CAN interface.

1. Make sure that your computer is turned off. Keep the computer 
plugged in so that it remains grounded while you install the CAN 
interface.

2. Remove the top cover (or other access panels) to give yourself ac
to the computer expansion slots.

3. Find an unused expansion slot of the appropriate type in your 
computer.

4. Remove the corresponding slot cover on the back panel of the 
computer.

5. Insert the CAN interface into the slot with the CAN connector(s) 
sticking out of the opening on the back panel. It might be a tight fit
but do not force the interface into place. Figure 2-3 shows how to 
install the AT-CAN into a 16-bit ISA expansion slot.

!
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Figure 2-3.  Installing the AT-CAN

6. Screw the mounting bracket of the CAN interface to the back panel
of the computer.

7. Replace the top cover (or the access panel to the expansion slot).

8. Turn on your computer and start Windows 95. Windows 95 should
automatically detect the CAN hardware and associate it with the 
NI-CAN software. A New Hardware Found dialog box appears, then
goes away on its own. If the dialog box does not go away, select 
Windows default driver and click the OK  button.

If the New Hardware Found dialog box does not appear when you
restart Windows 95, refer to Appendix B, Forcing Windows 95 to 
Detect the CAN Hardware.

When you have finished installing the hardware, proceed to the Connect the 
Cables section, later in this chapter.
Getting Started with CAN for Windows 95 2-4 © National Instruments Corporation
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Install Your PCMCIA-CAN or PCMCIA-CAN/2

Caution Before you remove the card from the package, touch the antistatic plastic packa
to a metal part of your system chassis to discharge electrostatic energy, which 
damage several components on your CAN interface.

1. Shut down your operating system and power off your system.

2. Insert the card into a free PC Card (PCMCIA) socket. The card ha
jumpers or switches to set. Figure 2-4 shows how to insert the card
how to connect the PCMCIA-CAN cable and connector to the card

Figure 2-4.  Inserting the PCMCIA-CAN

3. Connect the PCMCIA-CAN cable to the card.

4. Power on your computer.

When you have finished installing the hardware, proceed to the next 
section, Connect the Cables.

!

PCMCIA-CAN
Cable

PCMCIA
Socket

Portable
Computer
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Connect the Cables
Because exact cabling requirements will vary for each application, 
National Instruments does not provide cables, other than the 
PCMCIA-CAN cable. Refer to Appendix C, Cabling Requirements, for 
information about the cabling requirements of the CAN hardware.

After you have installed the CAN interface, connect your CAN cables 
the interface. The CAN hardware installation is now complete. Procee
the next section, Configure the NI-CAN Software.

Configure the NI-CAN Software
The NI-CAN Configuration utility is fully integrated with the Windows 95
Device Manager. You can use it to examine or modify the configuration
the NI-CAN software. The context-sensitive online help, available by 
right-clicking on any of the controls on the configuration utility tabs, 
includes all of the information that you need to configure the NI-CAN 
software properly.

To configure the NI-CAN software, double-click on the System icon under 
Start»Settings»Control Panel. In the System Properties dialog box that 
appears, select the Device Manager tab, click the View devices by type 
radio button at the top of the tab, and double-click the National 
Instruments CAN Interfaces icon. 

If there is no National Instruments CAN Interfaces item or if a circled X 
or exclamation point (!) appears through the eagle icon, the CAN interf
is not working properly. Figure 2-5 shows an example of an AT-CAN/2 th
is working properly, and Figure 2-6 shows an example of an AT-CAN/2 t
is not working properly. Refer to the Troubleshooting Device Manager 
Problems section of Appendix D, Troubleshooting and 
Common Questions, to resolve the problem.

Figure 2-5.  Device Manager Shows CAN Interface That Is Working Properly
Getting Started with CAN for Windows 95 2-6 © National Instruments Corporation
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Figure 2-6.  Device Manager Shows CAN Interface That Is Not Working Properly

To configure a particular interface, double-click on that interface in the 
of installed interfaces below National Instruments CAN Interfaces.

The Resources tab provides information about the hardware resources
assigned to the CAN interface. Use the Resources tab to examine the 
assigned resources to verify that there are no conflicts. The Conflicting 
Device List lists any conflicts. If conflicts exist, uncheck the Use 
automatic settings checkbox and use the Change Setting button to select 
conflict-free resources for the CAN hardware.

The Settings tab, shown in Figure 2-7, provides information about the 
NI-CAN software configuration for the CAN interface. 
© National Instruments Corporation 2-7 Getting Started with CAN for Windows 95
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Figure 2-7.  Settings Tab for the AT-CAN

Each port of the CAN hardware interface is configured from the same 
Use the drop-down box nearest the top of the tab to select the physica
number to configure. For each port, use the Name drop-down box to select 
the name for the CAN Network Interface Object (CAN0, CAN1, and so on). 
You use this name to refer to the physical port from within your NI-CA
application.

To access online help for the NI-CAN Configuration utility, right-click th
mouse anywhere on the Settings tab, and select Full Help from the pop-up 
menu that appears. Alternately, you can select What’s This? from the 
pop-up menu to see context-sensitive help for the item you have clicke

When you have finished configuring the NI-CAN software, proceed to 
Chapter 3, Verify the Installation.
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Verify the Installation

This chapter describes how to verify the hardware and software 
installation.

You can use the NI-CAN Diagnostic utility, installed with your NI-CAN 
software, to test the hardware and software installation. The utility verif
that your hardware and software are functioning properly and that the 
configuration of your CAN interfaces does not conflict with anything el
in your system.

To run the utility, select the NI-CAN Diagnostic item under 
Start»Programs»NI-CAN Software for Windows 95.

When you have started the NI-CAN Diagnostic utility, test your CAN 
interfaces by clicking on the Test All button. You can also test one CAN 
interface by highlighting it and clicking on the Test One button. If the 
NI-CAN Diagnostic is successful, it puts a checkmark next to the interfa
and changes its status from “Untested” to “Passed.” If the NI-CAN 
Diagnostic fails, it puts an X next to the interface, and changes its stat
from “Untested” to “Failed.” Figure 3-1 shows the NI-CAN Diagnostic 
utility after it has tested some CAN interfaces.

Figure 3-1.  NI-CAN Diagnostic Utility after Testing
 for Windows 95
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You can get details about any tested CAN interface by selecting the 
interface and clicking the Details button. For each failed CAN interface, 
select it and click the Details button to get a description of the failure. 
Use that information and the information in Appendix D, Troubleshooting 
and Common Questions, to troubleshoot the problem. Troubleshooting 
information is also available in the online help for the NI-CAN Diagnost
utility, which you can access by clicking on the Help button.
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Begin to Use the NI-CAN 
Software

This chapter helps you get started with the NI-CAN software for 
Windows 95.

Using the NI-CAN Software
The functions provided by the NI-CAN software are similar to those 
provided by many other device drivers. For example, NI-CAN has ope
close, read, and write functions. NI-CAN provides two different levels 
access to a CAN network: the CAN Network Interface Object and CAN
Objects. Both forms of access support timestamping of incoming data
well as various forms of queuing.

The CAN Network Interface Object provides low-level access to a CAN
network. Each CAN Network Interface Object maps to a specific CAN
port, with no limitation on the maximum number of ports or cards you c
use (for example, two AT-CAN/2 interfaces would provide CAN0 through 
CAN3). You can use this object to transmit and receive entire CAN fram
For example, to transmit a CAN frame, you would specify the outgoing
arbitration ID, frame type (data or remote), data length, and data.

The CAN Objects provide higher level access to a CAN network. Each
CAN Object maps to a specific data item (arbitration ID), and you can 
multiple CAN Objects for a given port. When configuring a CAN Objec
for use, you specify the arbitration ID, direction of data transfer, data 
length, and how you want the data to be accessed (such as periodically
example, you could configure a CAN Object to transmit an outgoing da
frame for a specific arbitration ID every 100 ms. After opening this CAN
Object, you use the write function to provide data to transmit, and the 
NI-CAN embedded firmware handles all periodic timing. 

For detailed information on the NI-CAN software and functions, refer t
the NI-CAN User Manual for Windows 95 and Windows NT and the 
NI-CAN Programmer Reference Manual for Win32.
 for Windows 95
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General Programming Considerations
As you begin developing your Win32 NI-CAN application, remember th
following points:

• For your LabVIEW application, you must use the NI-CAN LabVIEW
functions in nican.llb . 

• For your C/C++ application, you must include the NI-CAN header fil
nican.h , in your source code. 

• The NI-CAN software is accessed through the 32-bit DLL, 
nican.dll , either by linking with one of the language interfaces 
provided with the NI-CAN software, or by using direct DLL entry 
from other programming environments.

• Several sample CAN applications are included with the NI-CAN 
software. Use them as a guide for your own application developm

For information about developing your application, refer to the NI-CAN 
User Manual for Windows 95 and Windows NT. For detailed information 
about NI-CAN functions and objects, refer to the NI-CAN Programmer 
Reference Manual for Win32.
Getting Started with CAN for Windows 95 4-2 © National Instruments Corporation



© National Instruments Corporation A-1 Getting Started with CAN
A

 

Uninstalling the Hardware 
and Software

This appendix describes how to uninstall the CAN hardware and the 
NI-CAN software from Windows 95.

Uninstalling the CAN Hardware from Windows 95
Before physically removing the CAN hardware from the computer, you
must remove the hardware information from the Windows 95 Device 
Manager.

To remove the hardware information from Windows 95, complete the 
following steps.

1. Select Start»Settings»Control Panel. 

2. Double-click on the System icon.

3. In the System Properties dialog box that appears, select the 
Device Manager tab.

4. Click the View devices by type button at the top of the Device 
Manager tab.

5. Double-click on the National Instruments CAN Interfaces icon.

6. To remove an interface, select it from the list of interfaces under 
National Instruments CAN Interfaces as shown in Figure A-1, 
and click on the Remove button. 
 for Windows 95
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Figure A-1.  Selecting an Interface to Remove from Windows 95

After you remove the appropriate CAN interface information from the 
Device Manager, you should shut down Windows 95, power off your 
computer, and physically remove the CAN interfaces from your compu

Uninstalling the NI-CAN Software from Windows 95
Before uninstalling the NI-CAN software, you should remove all CAN 
interface hardware from your computer, as explained in the previous 
section.

Complete the following steps to remove the NI-CAN software.

1. Run the Add/Remove Programs applet from the Control Panel. A 
dialog box similar to the one in Figure A-2 appears. This dialog bo
lists the software available for removal.
Getting Started with CAN for Windows 95 A-2 © National Instruments Corporation
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Figure A-2.  Add/Remove Programs Properties Dialog Box

2. Select the NI-CAN software you want to remove, and click the 
Add/Remove button. The uninstall program runs and removes all 
folders, utilities, device drivers, DLLs, and registry entries associa
with the NI-CAN software. Figure A-3 shows the results of a 
successful uninstallation.
© National Instruments Corporation A-3 Getting Started with CAN for Windows 95
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Figure A-3.  NI-CAN Uninstallation Results

The uninstall program removes only items that the installation program
installed. If you add anything to a directory that was created by the 
installation program, the uninstall program does not delete that directo
because the directory is not empty after the uninstallation. You must 
remove any remaining components yourself.

If you want to reinstall the hardware and software, refer to Chapter 2, 
Installation and Configuration.
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Forcing Windows 95 to Detect 
the CAN Hardware

This appendix contains instructions to help you install your CAN interfa
if Windows 95 has not detected it properly. 

If Windows 95 does not detect your interface properly, it may not displ
the New Hardware Found dialog box when expected, and the NI-CAN 
Diagnostic utility reports no CAN interfaces present. This problem occ
if Windows 95 has already configured the CAN interface as an “other 
device.” To fix the problem, complete the following steps.

1. Select Start»Settings»Control Panel.

2. Double-click on the System icon to display the System Properties 
dialog box for the computer.

3. Click on the Device Manager tab at the top of the System Properties 
sheet to bring up the Device Manager property page. Make sure the 
View devices by type button at the top of the Device Manager page 
is selected.

4. Click on the + sign next to Other Devices to display a list of all the 
hardware devices that Windows 95 has detected and configured a
Other Devices. 

5. For each National Instruments CAN interface listed, select the 
interface by clicking on it, and then click on the Remove button to 
remove each interface from the list of Other Devices.

6. After you have removed all of the National Instruments CAN 
interfaces from the list of Other Devices, click on the Refresh button 
to force Windows 95 to detect each National Instruments CAN 
interface and to display a New Hardware Found dialog box for each 
one.

7. Proceed with the hardware installation, as described in Chapter 2
Installation and Configuration.
 for Windows 95
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Cabling Requirements

This appendix describes the cabling requirements for the CAN hardwa

Cables should be constructed to meet these requirements, as well as 
requirements of the other CAN or DeviceNet devices in the network.

Connector Pinouts
Depending on the type of CAN interface you are installing, the CAN 
hardware has DB-9 D-Sub connectors(s), or Combicon-style pluggabl
screw terminal connector(s), or both. 

The 9-pin D-Sub follows the pinout recommended by CiA DS 102. 
Figure C-1 shows the pinout for this connector.

Figure C-1.  Pinout for 9-Pin D-Sub Connector

The 5-pin Combicon-style pluggable screw terminal follows the pinout
required by the DeviceNet specification. Figure C-2 shows the pinout f
this connector. 

1
2

3
4

5

6
7

8
9

No Connection

CAN_L

V-

No Connection

Optional Ground (V-)

CAN_H

No Connection

V+
Shield
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Figure C-2.  Pinout for 5-Pin Combicon-Style Pluggable Screw Terminal

CAN_H and CAN_L are signal lines that carry the data on the CAN 
network. These signals should be connected using twisted-pair cable.

The V+ and V– pins are used to supply bus power to the CAN physica
layer if external power is required for the CAN physical layer. If interna
power for the CAN physical layer is used, the V- pin serves as the refere
ground for CAN_H and CAN_L. See the next section, Power Supply 
Information for the CAN Ports, for more information.

Figure C-3 shows the end of a PCMCIA-CAN cable. The arrow points
pin 1 of the 5-pin screw terminal block. All of the signals on the 5-pin 
Combicon-style pluggable screw terminal are connected directly to the
corresponding pins on the 9-pin D-Sub.

Figure C-3.  PCMCIA-CAN Cable
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Getting Started with CAN for Windows 95 C-2 © National Instruments Corporation



Appendix C Cabling Requirements

ith 
Power Supply Information for the CAN Ports
For the AT-CAN, AT-CAN/2, PCI-CAN, and PCI-CAN/2, the power 
source for the CAN physical layer is configured with a jumper. For the 
AT-CAN and port one of the AT-CAN/2, power is configured with 
jumper J3. For port two of the AT-CAN/2, power is configured with 
jumper J4. The location of these jumpers is shown in Figure C-4.

 

Figure C-4.  AT-CAN/2 Power Source Jumpers

For the PCI-CAN and port one of the PCI-CAN/2, power is configured w
jumper J6. For port two of the PCI-CAN/2, power is configured with 
jumper J5. These jumpers are shown in Figure C-5.

1 Power Supply Jumper J3
2 Serial Number

3 Assembly Number
4 Power Supply Jumper J4

5 Product Name

3

5 4

21
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Figure C-5.  PCI-CAN/2 Power Source Jumpers

Connecting pins 1 and 2 of a jumper configures the CAN physical laye
be powered externally (from the bus cable power). In this configuration,
power must be supplied on the V+ and V– pins on the port connector.

Connecting pins 2 and 3 of a jumper configures the CAN physical laye
be powered internally (from the card). In this configuration, the V– sign
serves as the reference ground for the isolated signals.

Figure C-6 shows how to configure your jumpers for internal or externa
power supplies.

Figure C-6.  Power Source Jumpers

The CAN physical layer is still isolated regardless of the power source
chosen.

1 Power Supply Jumper J6
2 Product Name

3 Serial Number
4 Assembly Number

5 Power Supply Jumper J5

3

5 4

1 2

INT EXT

a. Internal Power Mode

INT EXT

b. External Power Mode
(Device Net)

123 123
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The PCMCIA-CAN and PCMCIA-CAN/2 are available with two types o
cable. The DeviceNet (bus powered) cable requires that the CAN phys
layer be powered from the bus cable power.

The internal-powered cable supplies power to the CAN physical layer fr
the host computer. The V+ pin is not connected to any internal signals,
the corresponding pins on the 9-pin D-Sub and the 5 pin Combicon-st
connectors are still connected. The V– pins serves as the reference gr
for the isolated signals.

The CAN physical layer is isolated from the computer in both types of 
cable.

Bus Power Supply Requirements
If the CAN physical layer is powered from a bus power supply, the pow
supply should be a DC power supply with an output of 10 V to 30 V. T
power requirements for the CAN ports for Bus-Powered configurations 
shown in Table C-1. You should take these requirements into account w
determining requirements of the bus power supply for the system.

Cable Specifications
Cables should meet the physical medium requirements specified in 
ISO 11898, shown in Table C-2.

Belden cable (3084A) meets all of those requirements, and should be
suitable for most applications.

Table C-1.  Power Requirements for the CAN Physical Layer for 
Bus-Powered Versions

Characteristic Specification

Voltage Requirement V+ 10-30 VDC

Current Requirement 40 mA typical 
100 mA maximum
© National Instruments Corporation C-5 Getting Started with CAN for Windows 95
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Cable Lengths
The allowable cable length is affected by the characteristics of the 
cabling and the desired bit transmission rates. Detailed cable length 
recommendations can be found in the ISO 11898, CiA DS 102, and 
DeviceNet specifications.

ISO 11898 specifies 40 m total cable length with a maximum stub leng
of 0.3 m for a bit rate of 1 Mb/s. The ISO 11898 specification says tha
significantly longer cable lengths may be allowed at lower bit rates, bu
each node should be analyzed for signal integrity problems.

Table C-3 lists the DeviceNet cable length specifications.

Number of Devices
The maximum number of devices depends on the electrical characteri
of the devices on the network. If all of the devices meet the requireme
of ISO 11898, at least 30 devices may be connected to the bus. Highe
numbers of devices may be connected if the electrical characteristics 
the devices do not degrade signal quality below ISO 11898 signal leve
specifications. If all of the devices on the network meet the DeviceNet
specifications, 64 devices may be connected to the network.

Table C-2.  ISO 11898 Specifications for Characteristics of a CAN_H and 
CAN_L Pair of Wires

Characteristic Value

Impedance 108 Ω minimum, 120 Ω nominal, 
132 Ω maximum

Length-related resistance 70 mΩ/m nominal

Specific line delay 5 ns/m nominal

Table C-3.  DeviceNet Cable Length Specifications

Bit Rate Thick Cable Thin Cable

500 kb/s 100 m 100 m

250 kb/s 200 m 100 m

100 kb/s 500 m 100 m
Getting Started with CAN for Windows 95 C-6 © National Instruments Corporation



Appendix C Cabling Requirements

on 
he 

res 
oes 

ple 
 cable 
here 
 

nce 
 
le. 
 of 
Cable Termination
The pair of signal wires (CAN_H and CAN_L) constitutes a transmissi
line. If the transmission line is not terminated, each signal change on t
line causes reflections that may cause communication failures.

Because communication flows both ways on the CAN bus, CAN requi
that both ends of the cable be terminated. However, this requirement d
not mean that every device should have a termination resistor. If multi
devices are placed along the cable, only the devices on the ends of the
should have termination resistors. See Figure C-7 for an example of w
termination resistors should be placed in a system with more than two
devices.

Figure C-7.  Termination Resistor Placement

The termination resistors on a cable should match the nominal impeda
of the cable. ISO 11898 requires a cable with a nominal impedance of
120Ω; therefore, a 120 Ω resistor should be used at each end of the cab
Each termination resistor should each be capable of dissipating 0.25 W
power.

120 Ω 120 Ω

CAN_H

CAN_L
CAN

Device

CAN
Device

CAN
Device

CAN
Device
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Cabling Example
Figure C-8 shows an example of a cable to connect two CAN devices.
the internal power configuration, no V+ connection is required.

Figure C-8.  Cabling Example
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9-Pin
D-Sub
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CAN_L

GND
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Pin 7Pin 4 Pin 7 Pin 4

Pin 2 Pin 2

Pin 5 Pin 3

Pin 9 Pin 5

Pin 3 Pin 1

Pin 2Pin 2

Pin 5Pin 3

Pin 9Pin 5

Pin 3Pin 1
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Troubleshooting and 
Common Questions

This appendix describes how to troubleshoot problems and answers s
common questions.

Troubleshooting Device Manager Problems
The Windows 95 Device Manager contains configuration information f
all of the CAN hardware it is aware of that is installed in your system. 
start the Windows 95 Device Manager, double-click on the System icon 
under Start»Settings»Control Panel. In the System Properties box that 
appears, select the Device Manager tab and click the View devices by type 
radio button at the top of the tab. 

If there is no National Instruments CAN Interfaces item and you are 
certain you have a CAN interface installed, refer to the No National 
Instruments CAN Interfaces section of this appendix. 

If the National Instruments CAN Interfaces item exists, but the CAN 
interface you are looking for is not listed there, refer to the Missing CAN 
Interface section of this appendix.

If the CAN interface you are looking for is listed, but has a circled X or
exclamation mark (!) over its icon, refer to the Problem Shown in Device 
Manager section of this appendix.

No National Instruments CAN Interfaces
If you are certain you have a Plug and Play CAN interface installed, bu
National Instruments CAN Interfaces item appears in the Device 
Manager, the interface is probably incorrectly listed under Other Devices. 
Double-click on the Other Devices item in the Device Manager and, one
by one, remove each National Instruments CAN interface listed there 
selecting its name and then clicking the Remove button. After all of the 
National Instruments CAN interfaces have been removed from Other 
Devices, click the Refresh button. At this point, the system rescans the 
installed hardware, and the CAN interface should appear under National 
 for Windows 95
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Instruments CAN Interfaces without any problems. If the problem 
persists, contact National Instruments.

Missing CAN Interface 
If the National Instruments CAN Interfaces item exists, but the CAN 
interface you are looking for is not listed there, the CAN interface is no
properly installed. For National Instruments CAN hardware, this proble
indicates that the interface is not physically present in the system.

Problem Shown in Device Manager
If a CAN interface is not working properly, its icon has a circled X or 
exclamation mark (!) overlaid on it, as shown in Figure D-1. 

Figure D-1.  Device Manager Shows CAN Interface That Is Not Working Properly

This problem can occur for several reasons. If you encounter this prob
the Device Manager should list an error code that indicates why the 
problem occurred. To see the error code for a particular interface, selec
name of the interface and click on the Properties button to go to the 
General tab for that CAN interface. The Device Status section of the 
General tab shows the error code. Locate the error code in the followin
list to find out why your CAN interface is not working properly.

• Code 8: The NI-CAN software was incompletely installed. To solve
this problem, reinstall the NI-CAN software for Windows 95.

• Code 9: Windows 95 had a problem reading information from the 
CAN interface. Contact National Instruments for assistance.

• Code 12: The CAN interface was not assigned a physical memory
range. If your computer does not have 8 KB of available memory, 
Windows 95 might configure your CAN interface without a physica
memory assignment. The NI-CAN software for Windows 95 canno
function without 8 KB of physical memory. Another way to verify thi
problem is to look at the Resource settings list on the Resources tab 
to verify that the CAN interface was not assigned a Memory Range
Getting Started with CAN for Windows 95 D-2 © National Instruments Corporation
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solve this problem, free up an 8 KB Memory Range (such as D000
D1FFF hex) that is being used by another device in the system.

• Code 15: The CAN interface was not assigned an Interrupt Reque
level. If your computer does not have any available Interrupt Requ
levels, Windows 95 might configure your CAN interface without an
Interrupt Request level. The NI-CAN software for Windows 95 cann
function without an Interrupt Request level. Another way to verify th
problem is to look at the Resource settings list on the Resources tab 
to verify that the CAN interface was not assigned an Interrupt Requ
level. To solve this problem, free up an Interrupt Request level tha
being used by another device in the system.

• Code 22: The CAN interface is disabled. To enable the CAN interfa
check the appropriate configuration checkbox in the Device Usage 
section of the General tab.

• Code 24: The CAN interface is not present, or the Device Manage
unaware that the CAN interface is present. To solve this problem, 
select the interface in the Device Manager, and click on the Remove 
button. Next, click the Refresh button. At this point, the system 
rescans the installed hardware, and the CAN interface should sho
up without any problems. If the problem persists, contact National
Instruments.

• Code 27: Windows 95 was unable to assign the CAN interface an
resources. To solve this problem, free up system resources by disa
other unnecessary hardware so that enough resources are availab
the CAN interface. The resources required for a single CAN interfa
are an Interrupt Request level and an 8 KB physical memory rang
(such as D0000 to D1FFF hex).

Troubleshooting Diagnostic Utility Failures
The following sections explain common error messages generated by
NI-CAN Diagnostic utility.

Memory Resource Conflict
This error occurs if the memory resource assigned to a CAN interface
conflicts with the memory resources being used by other devices in th
system. Resource conflicts typically occur when your system contains
legacy boards that use resources that have not been reserved properly
the Device Manager. If a resource conflict exists, write down the mem
resource that caused the conflict and refer to the Microsoft Windows 95 
User’s Guide for instructions on how to use the Device Manager to rese
© National Instruments Corporation D-3 Getting Started with CAN for Windows 95
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memory resources for legacy boards. After the conflict has been resol
run the NI-CAN Diagnostic utility again.

Interrupt Resource Conflict
This error occurs if the interrupt resource assigned to a CAN interface
conflicts with the interrupt resources being used by other devices in th
system. Resource conflicts typically occur when your system contains
legacy boards that use resources that have not been reserved properly
the Device Manager. If a resource conflict exists, write down the interr
resource that caused the conflict and refer to the Microsoft Windows 95 
User’s Guide for instructions on how to use the Device Manager to rese
interrupt resources for legacy boards. After the conflict has been resol
run the NI-CAN Diagnostic utility again.

NI-CAN Software Problem Encountered
This error occurs if the NI-CAN Diagnostic utility detects that it is unab
to communicate correctly with the CAN hardware using the installed 
NI-CAN software. If you get this error, shut down your computer, restart
and run the NI-CAN Diagnostic utility again. If the problem persists, try
reinstalling the NI-CAN software for Windows 95. 

Missing CAN Interface
If a National Instruments CAN interface is physically installed in your 
system, but is not listed in the NI-CAN Diagnostic utility, check the 
Windows 95 Device Manager to see if Windows 95 has detected the 
hardware. For more information, refer to the Troubleshooting Device 
Manager Problems section, earlier in this appendix.

CAN Hardware Problem Encountered
This error occurs if the NI-CAN Diagnostic utility detects a defect in th
CAN hardware. If you get this error, write down the numeric code show
with the error, and contact National Instruments. Depending on the ca
of the hardware failure, National Instruments may need to upgrade yo
CAN interface.
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Common Questions
What do I do if my CAN hardware is listed in the Windows 95 Device 
Manager with a circled X or exclamation point (!) overlaid on it?

Refer to the Problem Shown in Device Manager section of this appendix 
for specific information about what might cause this problem. If you ha
already completed the troubleshooting steps, fill out the forms in 
Appendix F, Customer Communication, and contact National Instruments 

How can I determine which type of CAN hardware I have installed?

Run the NI-CAN Configuration utility. To run the utility, select 
Start»Settings»Control Panel»System. Select the Device Manager tab 
in the System Properties dialog box. Click on the View devices by type 
radio button at the top of the sheet. If any CAN hardware is correctly 
installed, a National Instruments CAN Interfaces icon appears in the list 
of device types. Double-click this icon to see a list of installed CAN 
hardware.

How can I determine which version of the NI-CAN software I have 
installed?

Run the NI-CAN Diagnostic utility. To run the utility, select the Diagnostic 
item under Start»Programs»NI-CAN Software for Windows 95. The 
NI-CAN Diagnostic utility displays information about the version of the
NI-CAN software currently installed.

Which CAN interfaces does the NI-CAN software for Windows 95 
support?

The NI-CAN software for Windows 95 supports the AT-CAN, AT-CAN/2
PCI-CAN, PCI-CAN/2, PCMCIA-CAN, and PCMCIA-CAN/2.

What do I do if the NI-CAN Diagnostic utility fails with an error?

Refer to the Troubleshooting Diagnostic Utility Failures section of this 
appendix for specific information about what might cause the NI-CAN 
Diagnostic utility to fail. If you have already completed the troubleshooti
steps, fill out the forms in Appendix F, Customer Communication, and 
contact National Instruments.
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How many CAN interfaces can I configure for use with my NI-CAN 
software for Windows 95? 

The NI-CAN software for Windows 95 can be configured to communica
with up to 10 CAN interfaces. 

Are interrupts required for the NI-CAN software for Windows 95?

Yes, one interrupt per interface is required.

How do I use an NI-CAN language interface?

For information about using NI-CAN language interfaces, refer to 
Chapter 3, Developing Your Application, in the NI-CAN User Manual 
for Windows 95 and Windows NT.

How do I use NI-CAN from within LabVIEW?

For information about using NI-CAN from within LabVIEW, refer to 
Chapter 3, Developing Your Application, in the NI-CAN User Manual for 
Windows 95 and Windows NT.

Why does the uninstall program leave some components installed?

The uninstall program removes only items that the installation program
installed. If you add anything to a directory that was created by the 
installation program, the uninstall program does not delete that directo
because the directory is not empty after the uninstallation. You must 
remove any remaining components yourself.

What information should I have before I call National Instruments?

When you call National Instruments, you should have all of the informat
filled out on the Hardware and Software Configuration Form in 
Appendix F, Customer Communication.
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Specifications

This appendix describes the physical characteristics of the CAN hardw
along with the recommended operating conditions.

Table E-1.  AT-CAN and AT-CAN/2 Hardware Characteristics

Characteristic Specification

Dimensions 10.67 by 16.51 cm
(4.2 by 6.5 in.)

Power Requirement +5 VDC 500 mA typical

I/O Connector 9-pin D-Sub for each port (standard)
or
5-pin Combicon-style pluggable 
DeviceNet screw terminal

Operating Environment
Component Temperature
Relative Humidity

0° to 55° C
10% to 90%, noncondensing

Storage Environment
Temperature
Relative Humidity

–20° to 70° C
5% to 90%, noncondensing
 for Windows 95



Appendix E Specifications
Table E-2.  PCI-CAN and PCI-CAN/2 Hardware Characteristics

Characteristic Specification

Dimensions 10.67 by 17.46 cm
(4.2 by 6.88 in.)

Power Requirement +5 VDC 775 mA typical

I/O Connector 9-pin D-Sub for each port (standard)
or
5-pin Combicon-style pluggable 
DeviceNet screw terminal

Operating Environment
Ambient Temperature
Relative Humidity

0° to 55° C
10% to 90%, noncondensing

Storage Environment
Temperature
Relative Humidity

–20° to 70° C
5% to 90%, noncondensing

Table E-3.  PCMCIA-CAN and PCMCIA-CAN/2 Hardware Characteristics

Characteristic Specification

Dimensions 8.56 by 5.40 by 0.5 cm
(3.4 by 2.1 by 0.4 in.)

Power Requirement 500 mA typical

I/O Connector Cable with 9-pin D-Sub and 5-pin 
Combicon-style pluggable screw 
terminal for each port

Operating Environment
Component Temperature
Relative Humidity

0° to 55° C
10% to 90%, noncondensing

Storage Environment
Temperature
Relative Humidity

–20° to 70° C
5% to 90%, noncondensing
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Table E-4.  CAN Port Characteristics for Bus-Powered Ports

Characteristic Specification

Power Requirement 10-30 V 40 mA typical
100 mA maximum

Isolation 500 VDC optical
© National Instruments Corporation E-3 Getting Started with CAN for Windows 95
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Customer Communication

For your convenience, this appendix contains forms to help you gather the information necessa
to help us solve your technical problems and a form you can use to comment on the product 
documentation. When you contact us, we need the information on the Technical Support Form
the configuration form, if your manual contains one, about your system configuration to answer
questions as quickly as possible.

National Instruments has technical assistance through electronic, fax, and telephone systems to
provide the information you need. Our electronic services include a bulletin board service, an FT
a fax-on-demand system, and e-mail support. If you have a hardware or software problem, first 
electronic support systems. If the information available on these systems does not answer you
questions, we offer fax and telephone support through our technical support centers, which are
by applications engineers. 

Electronic Services

Bulletin Board Support
National Instruments has BBS and FTP sites dedicated for 24-hour support with a collection of
and documents to answer most common customer questions. From these sites, you can also d
the latest instrument drivers, updates, and example programs. For recorded instructions on how
the bulletin board and FTP services and for BBS automated information, call 512 795 6990. Yo
access these services at:

United States: 512 794 5422
Up to 14,400 baud, 8 data bits, 1 stop bit, no parity

United Kingdom:  01635 551422
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

France:  01 48 65 15 59
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

FTP Support
To access our FTP site, log on to our Internet host, ftp.natinst.com , as anonymous  and use 
your Internet address, such as joesmith@anywhere.com , as your password. The support files and
documents are located in the /support  directories.
 for Windows 95
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Fax-on-Demand Support
Fax-on-Demand is a 24-hour information retrieval system containing a library of documents on a
range of technical information. You can access Fax-on-Demand from a touch-tone telephone a
512 418 1111.

E-Mail Support (Currently USA Only)
You can submit technical support questions to the applications engineering team through e-mai
Internet address listed below. Remember to include your name, address, and phone number so
contact you with solutions and suggestions. 

support@natinst.com

Telephone and Fax Support
National Instruments has branch offices all over the world. Use the list below to find the technic
support number for your country. If there is no National Instruments office in your country, cont
the source from which you purchased your software to obtain support.

Country Telephone Fax
Australia 03 9879 5166 03 9879 6277
Austria 0662 45 79 90 0 0662 45 79 90 19
Belgium 02 757 00 20 02 757 03 11
Brazil 011 288 3336 011 288 8528
Canada (Ontario) 905 785 0085 905 785 0086
Canada (Quebec) 514 694 8521 514 694 4399
Denmark 45 76 26 00 45 76 26 02
Finland 09 725 725 11 09 725 725 55
France 01 48 14 24 24 01 48 14 24 14
Germany 089 741 31 30 089 714 60 35
Hong Kong 2645 3186 2686 8505
Israel 03 6120092 03 6120095
Italy 02 413091 02 41309215
Japan 03 5472 2970 03 5472 2977
Korea 02 596 7456 02 596 7455
Mexico 5 520 2635 5 520 3282
Netherlands 0348 433466 0348 430673
Norway 32 84 84 00 32 84 86 00
Singapore 2265886 2265887
Spain 91 640 0085 91 640 0533
Sweden 08 730 49 70 08 730 43 70
Switzerland 056 200 51 51 056 200 51 55
Taiwan 02 377 1200 02 737 4644
United Kingdom 01635 523545 01635 523154
United States 512 795 8248 512 794 5678
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Technical Support Form
Photocopy this form and update it each time you make changes to your software or hardware, a
the completed copy of this form as a reference for your current configuration. Completing this f
accurately before contacting National Instruments for technical support helps our applications 
engineers answer your questions more efficiently.

If you are using any National Instruments hardware or software products related to this problem
include the configuration forms from their user manuals. Include additional pages if necessary.

Name ______________________________________________________________________

Company ___________________________________________________________________

Address ____________________________________________________________________

___________________________________________________________________________

Fax ( ___ ) ________________Phone ( ___ ) ______________________________________

Computer brand____________ Model ___________________Processor _____________________

Operating system (include version number) ________________________________________

Clock speed ______MHz   RAM _____MB Display adapter ________________________

Mouse ___yes   ___no     Other adapters installed ___________________________________

Hard disk capacity _____MB Brand______________________________________________

Instruments used _____________________________________________________________

___________________________________________________________________________

National Instruments hardware product model _____________ Revision  ____________________

Configuration _______________________________________________________________

National Instruments software product ___________________  Version  _____________________

Configuration _______________________________________________________________

The problem is: ______________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

List any error messages: _______________________________________________________

___________________________________________________________________________

___________________________________________________________________________

The following steps reproduce the problem: _______________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________
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Hardware and Software Configuration Form
Record the settings and revisions of your hardware and software on the line to the right of eac
Complete a new copy of this form each time you revise your software or hardware configuration
use this form as a reference for your current configuration. Completing this form accurately bef
contacting National Instruments for technical support helps our applications engineers answer 
questions more efficiently.

National Instruments Products
General Information
CAN Interface Type (such as AT-CAN/2) _________________________________________

NI-CAN Diagnostic Utility Results ________________________________________________

Version Information
To access complete version information, including the hardware version and the NI-CAN 
driver version, open the MS-DOS Prompt and change to the NI-CAN installation directory 
(usuallyc:\nican ). At the prompt, enter the following command:

candiag -v

Version Information from the NI-CAN Diagnostic ____________________________________

___________________________________________________________________________

Other Products
Resource Summary Report from the Device Manager
To create this report, first display the System Properties dialog box for the computer by 
double-clicking on the System icon under Start»Settings»Control Panel. Then click on the 
Device Manager tab and highlight the Computer icon. Click on the Print  button, and check the 
Print to File  checkbox in the Print  dialog box before clicking on OK .

Programming Environment Information

Programming Language _______________________________________________________

Compiler Vendor_____________________________________________________________

Compiler Version ____________________________________________________________

Application Information
LabVIEW Application _________________________________________________________

Win32 Application ____________________________________________________________

If Win 32, method of accessing DLL (link with language interface or direct entry?) __________

___________________________________________________________________________



____
Documentation Comment Form
National Instruments encourages you to comment on the documentation supplied with our products. 
This information helps us provide quality products to meet your needs.

Title: Getting Started with Your CAN Hardware and the NI-CAN™ Software 

for Windows 95

Edition Date: January 1998

Part Number: 321371C-01

Please comment on the completeness, clarity, and organization of the manual.

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

If you find errors in the manual, please record the page numbers and describe the errors.

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

Thank you for your help.

Name _________________________________________________________________________

Title ______________________________________________________________________

Company _______________________________________________________________________

Address ________________________________________________________________________

_______________________________________________________________________________

E-Mail Address__________________________________________________________________

Phone ( ___ ) __________________________  Fax ( ___ ) _______________________________

Mail to: Technical Publications Fax to: Technical Publications
National Instruments Corporation National Instruments Corporation
6504 Bridge Point Parkway 512 794 5678
Austin, Texas 78730-5039



Glossary
Prefix Meanings Value

n- nano- 10–9

m- milli- 10–3

c- centi- 10–2

k- kilo- 103

M- mega- 106

° degrees

Ω ohms

% percent

A amperes

AC alternating current

ANSI American National Standards Institute

AT-compatible compatible with the 16-bit Industry Standard Architecture

b bits

C Celsius

CAN Controller Area Network

CiA CAN in Automation

DLL dynamic link library

DMA direct memory access

EMI electromagnetic interference

FCC Federal Communications Commission

Hz hertz

IEEE Institute of Electrical and Electronic Engineers

in. inches
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ding 
uch 
IRQ interrupt request

ISA Industry Standard Architecture

ISO International Standards Organization

KB kilobytes of memory

m meters

MB megabytes of memory

PC personal computer

PCI peripheral component interconnect

PCMCIA Personal Computer Memory Card International Association

RAM random-access memory

resource hardware settings used by National Instruments CAN hardware, inclu
an interrupt request level (IRQ) and an 8 KB physical memory range (s
as D0000 to D1FFF hex)

s seconds

V volts

VDC volts direct current

W watts
Getting Started with CAN for Windows 95 G-2 © National Instruments Corporation
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